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Quick-start tutorial

IN THIS CHAPTER

e Exercise 1: Building a catalog
of geographic data

e Exercise 2: Exploring data and
adding it to a map

* Exercise 3: Managing
shapefiles

e Exercise 4: Managing cover-
ages

ArcCatalog lets you explore and manage your data. After connecting to
your data, use the Catalog to explore its contents. When you find the data
you want to use, you can add it to a map. Often when you get data for a
project, you can’t use it right away; you may need to change its projection
or format, modify its attributes, or link geographic features to attributes
stored in another table. When the data is finally ready, you should document
its contents and the changes you have made. These data management
tasks can all be accomplished using tools that are available in the Catalog.

The easiest way to find out what you can do with ArcCatalog is to com-
plete the exercises in this tutorial.

» Exercise 1 shows you how to build your own catalog of geographic data
by adding data to and removing data from the Catalog.

» Exercise 2 illustrates how to explore and search for data and how to add
it to a map.

» Exercises 3 and 4 show you how to define a data source’s coordinate
system, modify its contents, join attributes in another table to the
data, and symbolize features based on the joined attributes. Exercise 3 is
for ArcView® and ArcEditor™ users, while Exercise 4 is targeted
for ArcInfo users.

This tutorial is designed to let you work at your own pace. You'll need
between two and four hours of focused time to complete the tutorial.
However, you can also perform the exercises one at a time if you wish.



Exercise 1: Building a catalog of geographic data

When you build a catalog, you're choosing the data you
want to work with. You might use several folders of data to
complete your project, while someone else might use data
stored in a geodatabase. For this tutorial, you’ll be working
with data from Yellowstone National Park, which is located
in the northwestern part of the United States.

In this exercise, you’ll add the folder containing the tutorial
data to the Catalog. Because you modify this data in later
exercises, you’ll create a working copy of the folder and
then remove items that you don’t need from the Catalog.

Start ArcCatalog

Before you can complete the tasks in this tutorial, you must
start ArcCatalog.

1. Click the Start button on the Windows taskbar.

2. Point to Programs.

3. Point to ArcGIS.

4. Click ArcCatalog. The ArcCatalog window appears.
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What’s in the Catalog?

On the left of the ArcCatalog window, you see the Catalog
tree; it gives you a bird’s-eye view of how your data is
organized. On the right are tabs that let you explore the
contents of the selected item in the Catalog tree.
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The first time you start ArcCatalog, it contains folder
connections that let you access your computer’s hard disks.
The Catalog also contains folders that let you create and
store connections to databases and Internet servers and
manage geocoding services and search results.
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When you select a connection, you can access the data to
which it’s linked. Folder connections let you access folders,
or directories, on local disks or shared folders on the
network. Database connections let you access the contents
of a database. When you remove folder or database connec-
tions from the Catalog, you are only removing the connec-
tion, not deleting the data.

Together, your connections create a catalog of geographic
data sources. Individual folders and data sources are ifems
in that catalog. If you use ArcInfo Workstation, you’re
accustomed to using the term “item” when referring to a
coverage’s attributes; in this book, “item” refers only to an
element in the Catalog tree.

Look in a folder connection

When you select a folder connection in the Catalog tree, the
Contents tab lists the items it contains. Unlike Windows
Explorer, the Catalog doesn’t list all files stored on disk; a
folder might appear empty even though it contains several
files. Folders containing geographic data sources have a
different icon to make your data easier to find.

Look in a folder connection in your catalog.

1. Click a folder connection in the Catalog tree. The items
it contains appear in the Contents tab. Here, the work
folder doesn’t contain geographic data; it has a plain
folder icon. The icon used by the Workspace folder
shows that it contains geographic data.
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2. Double-click a folder in the Contents list. That folder is
selected in the Catalog tree, and the Contents tab lists
the folders and geographic data it contains.

Using this method, you can browse through the contents of
disks looking for geographic data.

Locate the tutorial folder

Before you can start exploring the data for this tutorial, you
must select the folder where the tutorial data is located. In
the Catalog, you can quickly select any folder on your
computer or on the network as long as you know its path.

1. Click in the Location text box.

2. Type the path to the ArcGIS\ArcTutor folder on the
local drive where you installed the tutorial data; for
example, type “C:\ArcGIS\ArcTutor”.

If the data was installed by your system administrator in
a shared folder on the network, the path to the tutorial
folder includes the names of the computer and the share
through which the folder is accessed; for example,
“\\dataserver\public\ArcGIS\ArcTutor”.
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3. Press Enter. The folder is selected in the Catalog tree.
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When the Catalog already contains a folder connection that
can access the ArcGIS\ArcTutor folder, that connection
expands and the tutorial folder is selected in the Catalog
tree. Otherwise, a new folder connection is added to the
Catalog that directly accesses the ArcGIS\ArcTutor folder.

The path you typed above is added to the Location list after
you press the Enter key. To access the ArcGIS\ArcTutor
folder again in the future, you can choose its path from the
list by clicking the Location dropdown arrow.

Create a working copy of the tutorial data

In Exercises 2, 3, and 4, you will create new items and
modify the data provided for this tutorial. When processing
data, it is best to work on a copy so that your original data
will remain unmodified. To prepare for those exercises, use
ArcCatalog to copy the ArcGIS\ArcTutor\Catalog folder to
a location where you have write access. You will need

15 MB of free disk space to store the tutorial data.

1. If the Catalog doesn’t have a connection to the place
where you want to store the tutorial data, type its name
into the Location combo box and press Enter; for
example, type “C:\”. A new folder connection will be
added to the Catalog. Substitute the name of your folder
connection for “C:\” in the following steps.

2. Click the ArcGIS\ArcTutor folder or folder connection
in the Catalog tree.

Click the Catalog folder in the Contents tab.
4. Click the Copy button.
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5. Click the C:\ folder connection in the Catalog tree.

6. Click the Paste button. A new folder called Catalog will
appear in the Contents list for the C:\ folder connection.

7. Click the new Catalog folder in the Contents tab.
8. Click the File menu and click Rename.
9. Type “Cat_Tutorial” and press Enter.

If you type another name for the folder, that name must
have 13 characters or less and cannot use spaces.
Because the tutorial data includes coverages, the
folder’s name must satisfy these requirements for
Arclnfo workspaces. For the rest of the tutorial, substi-
tute the name of your folder for “C:\Cat_Tutorial”.

x|l Contents I F'reviewl Metadatal
Catalo
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Now that you have a working copy of the tutorial data, you
can connect directly to it in the Catalog.

Connect directly to your copy of the tutorial data

Folder connections in the Catalog can access specific
folders on disk. You might establish several connections to
different folders on the same disk. You don’t have to see all
the data on your C:\ drive, for example, just because you
want to use data in two of the folders it contains.

To create a connection that directly accesses a folder, you
can use a shortcut provided by the Catalog.

1. Click the Cat_Tutorial folder in the Contents list.
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2. Scroll to the top of the Catalog tree.

~

3. Drag the Cat_Tutorial folder from the Contents tab and
drop it on the Catalog at the top of the Catalog tree.
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A new folder connection is added to the Catalog.
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Creating folder connections using this shortcut is handy
when you’re browsing through local disks that contain many
folders, some of which contain geographic data.

Remove folders that you don’t need

For the remaining tasks in this tutorial, you only need to use
the folder connection that accesses your working copy of
the tutorial data. You can remove all other folder connec-
tions from the Catalog. To hide folders such as Database
Connections, you must change the settings in the Catalog’s
Options dialog box.

1. Click the C:\ folder connection.

2. Click the Disconnect From Folder button. The connec-
tion is removed from the Catalog.

QUICK-START TUTORIAL
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Repeat steps 1 and 2, removing each folder connection
in turn, except for the C:\Cat_Tutorial folder connec-
tion.

4. Click the Tools menu and click Options.
Click the General tab.

6. In the top level entries list, uncheck Database Connec-
tions, Internet Servers, and Geocoding Services. Coor-
dinate Systems is unchecked by default.

Optiong HE

General | Filz T}lpesl Contenlsl Metadatal Tablesl Hastell

— "hat top level entries do you want the Catalog to contain?

[ 1Geocoding Services ;I
[1Databaze Connections
[Intemet Servers

=

[]Coordinate Systems

— "Which types of data do you want the Catalog to show?

[w]Additional file types [specified in the File Types tab) -
[w]Arcinfo Coverages, Feature Claszes and Info Tables
[W]CAD Feature D atasets, Feature Classes and Drawings

7. Click OK.

Only the C:\Cat_Tutorial folder connection and the Search
Results folder remain in the Catalog. Now you can explore
the tutorial data without seeing folders and data that aren’t
essential to the task at hand.

You can continue on to Exercise 2 or stop and complete the
tutorial at a later time. If you do not move on to Exercise 2
now, do not delete your working copy of the tutorial data
and do not remove the folder connection that accesses the
working copy of the tutorial data from the Catalog.
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Exercise 2: Exploring data and adding it to a map

Each of the Catalog’s three tabs provides a different way to
explore the contents of the selected item in the Catalog
tree. Within each tab there are different views that let you
change the appearance of the selected item’s contents.

The Contents tab lists the items contained by the selected
item in the Catalog tree, for example, the items in a folder.
When a data source such as a shapefile is selected, the
Preview tab lets you see the geographic or attribute data it
contains. The Metadata tab lets you see documentation
describing the item’s contents.

ArcCatalog and ArcMap work together to make it easy to
build maps. For your project you are mapping the forest
resources in the southeastern corner of Yellowstone Na-
tional Park. In the Yellowstone folder is a map of the study
area; it is incomplete. In this exercise, after exploring the
data in the folder, you’ll add more data to the map.

The Contents tab

When you select items such as folders or geodatabases in
the Catalog tree, the Contents tab lists the items they
contain. To change the appearance of the Contents list, use
the appropriate buttons on the Standard toolbar.

Thumbnails
I
— 1
=8 T a
ListJ |—

Large Icons

|3 @ X

Details

Large Icons view represents each item in the list with a
large icon. List view uses small icons. Details view shows
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properties of each item in columns; you can sort the list by
the property values. Thumbnails view displays a snapshot
for each item in the list, providing a quick illustration of
the item’s geographic data.

Items such as maps, shapefiles, and tables don’t contain
other items. When you select them in the tree, the Contents
tab lists the item’s properties and its thumbnail.

Explore the contents of the Yellowstone folder

Each type of geographic data has its own set of icons in the
Catalog. The Yellowstone folder contains a personal
geodatabase, coverages, shapefiles, raster datasets, a TIN
dataset, a dBASE® table, and an ArcMap map document.
Geodatabases let you store spatial data inside a relational
database; personal geodatabases can be accessed by only
one person at a time. For more information, see Chapter 3,
‘Catalog basics’.

The Yellowstone folder also contains two layers. A layer
includes a shortcut to geographic data and information such
as the symbology used to draw geographic data on a map,
the query used to select which features the layer represents,
and properties defining how those features are labeled.

Use the Contents tab to find out about the data in the
Yellowstone folder.

1. Double-click the C:\Cat_Tutorial folder connection in
the Catalog tree.

2. Click the Yellowstone folder in the Catalog tree.

98]

Click the Large Icons button.
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4. Click the List button.
5. Click the Details button. The Type column in Details

view will help you learn which icon represents which
type of data. You can find more information about data
types and their icons in Chapter 4, “What’s in the
Catalog’.

Contents I Previewl Metadatal

Mame | Type
Eellowstone Persanal Geodatabase
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49 hydrology Laper
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veatype dBASE File
@yellowstone tap Document

Click the heading of the Type column to sort the items
by type.

Click the heading of the Name column to sort the items
by name.

QUICK-START TUTORIAL

10.

I1.

12.

Items that contain other items, such as geodatabases
and coverages, always appear at the top of the Contents
list. They are grouped by type.

Click the Thumbnails button and scroll down through the
snapshots. Items that are not geographic data sources,
such as the yellowstone geodatabase, can’t have
thumbnails; their icons appear on a gray background.

Cantents IPrewewI Metadata

' =l

Click the Details button.

Double-click the yellowstone personal geodatabase in
the Contents tab. It contains a feature dataset called
water and a feature class called roads.

Double-click the water feature dataset in the Contents
tab. It contains three feature classes called lakes, rivers,
and streams, respectively.

Click the states coverage in the Catalog tree to list the
feature classes it contains.

13
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13. Click the tin_study TIN dataset in the Catalog tree. This
surface represents the terrain of the study area. Because
a TIN dataset doesn’t contain other items, the Contents
tab lists its properties and thumbnail instead.

Contents |F'review| Metadalal

Mame:  tin_study
Type: TIN Dataset

tin_ztudy

Thumbnails give you a quick look at an item’s geographic
data; they’re useful when browsing through folders.
However, you must often see the data in more detail to
determine whether or not you want to use it.

The Preview tab

The Preview tab lets you explore the selected item’s data in

either Geography or Table view. For items containing both
geographic data and tabular attributes, you can toggle
between the Geography and Table views using the
dropdown list at the bottom of the Preview tab.

14

eography j

Geography view draws each feature in a vector dataset,
cach cell in a raster dataset, and each triangle in a TIN
dataset. When drawing geographic data, the Catalog uses a
default set of symbology. When drawing a layer’s contents,
the Catalog uses the symbology stored in the layer. You can
explore the selected item’s geographic data using the
buttons on the Geography toolbar.

Table view draws all rows and columns and the value for
cach cell in the selected item’s table. You can explore the
values in the table using the scroll bars, the buttons at the
bottom of the table, and the context menus that are avail-
able from the column headings.

Look at the Yellowstone data in Geography view

Use Geography view to look at the data contained by the
items in the Yellowstone folder. When using Geography
view, the Geography toolbar is enabled. You can use the
Zoom In, Zoom Out, Pan, Full Extent, and Identify buttons
on the toolbar to explore geographic data.

Zoom In Palm Identify
I I
laam @ e
| |
Zoom QOut  Full Extent

While you look at the Yellowstone data, you may wish to
see the geographic features in more detail using these tools.

Using ArRcCATALOG



For more information about how these buttons work, see
Chapter 7. “Exploring an item’s geography’.
1. Click the dem30 raster dataset in the Catalog tree. This

dataset contains elevation information for the study area
within the park.

2. Click the Preview tab. The raster draws using the
default grayscale color ramp.

98]

Click the elevation layer in the Catalog tree. The raster
draws using the symbology stored in the layer—a green
to red color ramp.

Cortents Freview | Motadata]

4. Click the study area shapefile in the Catalog tree. It
represents the study area for this project, which lies in
the southeastern corner of the park.

5. In the Catalog tree, click the plus sign next to the
vegetation coverage. The coverage’s feature classes are
listed in the Catalog tree.

6. In the Catalog tree, click each feature class in the
vegetation coverage in turn and look at their contents in
Geography view. This polygon coverage represents the
different types of vegetation within the study area.

QUICK-START TUTORIAL

Contorts Previen | Wetadats |

7. Click the Preview dropdown arrow at the bottom of the
Preview tab and click Table.

8. In the Catalog tree, click each feature class in the
vegetation coverage in turn and look at their contents in
Table view.

All feature classes in a coverage have FID and Shape
columns. They may also have several pseudo items
whose names begin with a dollar sign ($), which are
maintained by ArcInfo. Because topology only exists
for the polygon feature class, it’s the only one that has a
feature attribute table and therefore additional at-
tributes.

9. Click the Preview dropdown arrow at the bottom of the
Preview tab and click Geography.

10. In the Catalog tree, click the plus sign next to the water
feature dataset in the yellowstone geodatabase. The
feature classes it contains appear in the Catalog tree.

Elg vellovstorne
ElLEiJ waker
5 lakes
Tivers
] strearns
madz
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11. In the Catalog tree, click each feature class in the water
feature dataset in turn and look at their contents in
Geography view. The feature dataset groups feature
classes that contain different types of water features
throughout the park: lakes, rivers, and streams.

12. Click the lakes feature class in the Catalog tree.

13. Click the Identify button on the Geography toolbar and
click one of the larger lakes in the Preview tab. Its
attributes appear in the Identify Results window. Only
the larger lakes in this feature class have names.

Froperty Walue
FID 134
Shape
Shape_Length 34354 454014
Shape_fiea 28140025 856559
Marne Shoshone Lake

4] |

All features within three pixels of where you clicked are
selected; each feature is listed on the left of the Identify
Results window. If a data source has no text attributes,
a numeric attribute will be used to identify the features.

14. Click the Close button to close the Identify Results
window.

15. Click the hydrology layer in the Catalog tree. This group
layer presents all features in the lakes, rivers, and
streams feature classes using symbology stored in the
layer. When added to a map, a group layer only has one
entry in the table of contents.

16

Conterts Preview | petadeta]

i e"[{-

By exploring a data source’s data in Geography view, you
can find out if it has the features you need and if those
features have the correct attributes. This information can
help you decide whether or not to add the data to a map.

Explore the contents of a table

With the table exploration tools available in the Catalog, you
can learn a great deal about a table’s contents. You can
search for values in the table and sort records according to
the values in one or more columns.

The vegetation coverage represents areas with distinct
types of vegetation. The vegtype table contains both
general information, such as whether or not the area is
forested, and detailed information such as which plant
species live in each area. Throughout the park, 67 vegeta-
tion groups have been defined. Some areas, such as open
water or rocky peaks, may not have any vegetation at all.

Use the tools available in Table view to explore the con-
tents of the vegtype table.

1. Click the vegtype dBASE table in the Catalog tree.

Using ArRcCATALOG



2. Explore the table’s values using the buttons at the
bottom of the table. Once you click in the table you can
also use the arrow keys on the keyboard.

Beginning of table Current record

Number of
l records in
Record: ﬂ_"lJ 1 ‘H H“ of BB — the table
Previous record  Next record End of table

Type “10” into the Current record text box and press
Enter. The Current record icon appears next to the tenth
row in the table. The Object ID value for this record,
which is located in the OID column, is nine; the OID
values begin at zero.

98]

4. Scroll horizontally through the table until you see the
column named “Primary”.

5. Right-click the heading of the Primary column and click
Freeze/Unfreeze Column. The Primary column is frozen
in position at the left of the table, and a heavy black line
appears to its right.

Cortents  Preview |Metadata|
PAIMAY i NAMI ~
M either = Sot Ascending
|dahi Fescue S Sot Descending Hairgrass
|daho Fezcue Citistics nch Wwheatgrass
Lodgepale Fine edge
Big Sagebruzh Delete Field unch Wheatgrass
Alpine tundra Freeze/Unfreeze Column —
|daha Fescue dzon's Mesdlegrass

6. Scroll horizontally through the table. The Primary
column stays in place while the other columns scroll
normally. Place the Type column to the right of the
Primary column.

QUICK-START TUTORIAL

7. Position the mouse pointer over the right edge of the
Primary column’s heading. The mouse pointer changes.

8. Click and drag the edge of the Primary column’s
heading to the left. The red line indicates the edge’s
original position, while the black line shows its new
location. Drop the edge of the column. The column is
narrower.

Cortents Preview | Metadata

PRIMARY TYPE NAME1 =
Neither neither MNeither
|daho Fescue non-forest |daho Fezcue/Tufted Hairgraz
Idaho Fescue rion-forest |daho Fescue/Blugbunch wWh
Lodgepale Fine forest Lodgepole Pine Elk Sedge
Big Sagebrush nan-farest Big Sagebruzh/Bluebunch \w
Alpine tundra naon-farest Alpine tundra

Idaho Fescue ron-forest |daho Fescue/Richardson's N

9. Right-click the heading of the Type column and click
Freeze/Unfreeze Column. The heavy black line is now
to the right of the Type column. Scroll horizontally
through the table. Both the Primary and Type columns
stay in place while the other columns scroll normally.

10. Click the Type column’s heading. The column is high-
lighted in light blue.

11. Click and drag the Type column’s heading to the left of
the Primary column. The red line indicates the Type
column’s new position. Drop the column in the new

location.
Corterts  Preview | Metadata
PRIMARY TYPE CODE2 NAMET «
Neither nigither Meither
Idaho Fescue ron-forest |daho Fescue/Tufted Hairgrass
|daho Fescue non-forest |daho Fezcue/Blusbunch Wheatgl
Lodgepale Fine forest Lodgepole Fine/Elk Sedge
Big Sagebriuzh non-forest Big Sagebruzh/Blusbunch wheatc
Alpine tundra naon-farest Alpine tundra
Idaho Fescue nioh-farest ldaho Fescue/Richardson's Meedh
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The Type column now appears to the left of the Primary
column, and the heavy black line appears to the right of
the Primary column.

12. Hold down the Ctrl key and click the Primary column’s
heading. Both columns are now selected.

13. Right-click the heading of the Primary column and click
Sort Descending.

Cantents  Preview | Metadata I
TYPE BRIMARY . NAMET ~

niither Meither 1
non-forest |daho Fescue Fescue/Tufted Hairgrazs
naonfarest |daho Fescue i Fescue/Bluebunch Wheatg
farest Ladgepale Pine Epole Fine/Elk Sedge
naonfarest Big Sagebrush Delete Field Egebrush/Blusbunch Wheate
nonfarest Alping tundra Ereeeinfiesss Sl tundia
non-forest |daho Fescue Fescue/Richardson's Meedh

The rows in the table are sorted alphabetically in
descending order, first by the values in the Type col-
umn, then by the values in the Primary column. In this
format, the table presents vegetation information from
general to detailed as you look at the columns from left
to right.

Cortents  Preview |Metadata

TYPE PRIMARY NAME1 =
wet farest Subalpine Fir Subalpine Fir/Grause ‘Whortlebernywhitebark Pine Phaze

wel forest Subalpine Fir Subalpine Fir/Grouse Whortlebeny-Grouse ‘whortlebermy Pha
water ‘e ater i ater

non-forest Wfillow Willow/S edge

non-forest Tufted Hairgrass Tufted Hairgrazs/S edge

Tutted Hairgrass Tufted Hairgrass/Sedge

Talus Talus

non-forest

non-forest

After exploring the contents of the vegtype table, you have
a better idea about the forest resources that are available in
the study area. However, you may not know what some
column names in the table mean. For that information, you
must look at the table’s metadata.
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The Metadata tab

The Metadata tab shows descriptive information about the
selected item in the Catalog tree. Metadata includes
properties and documentation. Properties are derived from
the data source, while documentation is information
provided by a person.

Metadata is stored as extensible markup language (XML)
data in a file with the data or in a geodatabase. The Catalog
uses an extensible stylesheet language (XSL) stylesheet to
transform the XML data into a hypertext markup language
(HTMI,) page. You can change the metadata’s appearance
by changing the current stylesheet using the dropdown list
on the Metadata toolbar.

J Shlezhest: ESRI
~ |ESHI

EEAE

FGOC FAQ
Fl

You can browse through the available metadata just as you
would browse through any Web page in a browser.

Explore metadata for the tutorial data

The metadata for the Yellowstone folder provides an
overview of the data it contains. By looking at metadata for
the study area shapefile and vegetation coverage, you can
find out when and why the data was created and look at the
data’s properties.

1. Click the Yellowstone folder in the Catalog tree.

2. Click the Metadata tab. A metadata HTML page de-
scribing the contents of the Yellowstone folder appears.
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Contents | Preview Metadata |

Yellowstone National Park
Study Area

Ahout this folder

The data in this folder is being used to study of the forest resources
available in the park. The study will focus on the impact of the 1988
fire on the forested areas. Data will be gathered that describes the
plant species that could be found within the park both before and after
the fire. Special attention will be paid to sensitive areas within the park
both for wegetation and wildlife. Below are brief descriptions of the
data sources in this folder

o Vegetation - ArcInfo coverage representing the different
types of vegetation that could be found within the shudy area
before the 1988 fire =

Click the study_area shapefile in the Catalog tree.
Metadata is presented with the ESRI stylesheet by
default.

Contents | Preview Metadata |

Study area within Yellowstone National
Park

Shapefile

Description Spatial Attributes

Keywords
Theme: study arsa =l

The Catalog automatically adds the item’s current
property values to the metadata when you view it in the
Metadata tab.

Click the Stylesheet dropdown arrow on the Metadata
toolbar and click FGDC. Click the Stylesheet dropdown
arrow again and click FGDC FAQ. Different stylesheets
present the same body of metadata in different ways.

QUICK-START TUTORIAL

Corteres | Previen Meladats |

Study area within Yellowstone :I
National Park

Metadata:

Contents | Frevien Melarkla |

» Identification_Information N
» Spatial Data_Crganization Infol| Study area within Yellowstone National Park

o Spatial Reference_Information

+ Entity_and_Attribute T Frequently-asked g
» Distribution_Information
s Metadata_Reference Informatid o TWhat does this data set describe?

1. How should this data set be cited?

2. What geographic area does the data set cover?

3. What does it look like?

4. Does the data set describe conditions during a particular time
4| period?

Identification_Informaion:

5. What iz the general form of this data set?
6. How does the data set represent geographic features?
7. How does the data set describe geographic features?
« Who produced the data set?
1. Whe are the origmaters of the data set?
2. Whe also contributed to the data set?
3. To whem should users address questions about the data®? _ILI
| 3

4]

Click the Stylesheet dropdown arrow on the Metadata
toolbar and click ESRI.

Click the Spatial tab in the metadata.

Underneath the name of the coordinate system used by
the data, click Details. The coordinate system’s proper-
ties appear. Click Details again to hide the information.

Scroll down to see the shapefile’s extent. Its bounding
coordinates are presented both in the actual coordinates
of the data and in decimal degrees.

Click the boundary shapefile in the Catalog tree.

. Click the Spatial tab in the metadata. No coordinate

system information is available because the shapefile’s
projection hasn’t yet been defined. Scroll down to see
the data’s extent in projected coordinates.

Because there is no coordinate system information, the
Catalog cannot calculate the extent in decimal degrees.
If you have ArcView or ArcEditor, you’ll define the
shapefile’s coordinate system in Exercise 3.
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Contents | Preview Metadata |

=
Description m Attributes

Bounding coordinates
Horizontal

In decimal degrees
West: Wastern-most coordinate of the limit of
coverage espressed in longitude. REQUIRED
East; Eastern-most coordinate of the limit of
coverage expressed in longitude. REQUIRED
North: Morthern-most coordinate of the limit of
coverage expressed in latitude, REQUIRED.
South: Southern-most coordinate of the limit of
coverage expressed in latitude, REQUIRED,

In projected or local coordinates
Left: 487711.549252
Right: 593231.508358
Top. 4994761181968
Bottorn: 4886446481918 j

By default, when you look at metadata in the Metadata
tab, the Catalog automatically creates metadata if it
doesn’t already exist. On creation, it adds the current
property values along with hints about the type of
documentation you should provide. These hints appear
as gray text when using the ESRI stylesheet.

While metadata isn’t required to meet any standard, the
metadata created by the Catalog will follow the Federal
Geographic Data Committee (FGDC) Content Standard
for Digital Geospatial Metadata. 1f all the suggested
documentation is completed, your metadata will meet
the FGDC standard’s minimum requirements.

11. Click the vegetation coverage in the Catalog tree.

12. Click the Spatial tab in the coverage’s metadata. Like
the boundary shapefile, this coverage’s projection
hasn’t been defined, and the data’s extent in decimal
degrees hasn’t been calculated. If you have Arclnfo,
you’ll define its coordinate system in Exercise 4.

13. Click the Attributes tab in the metadata. Attributes are
listed for each coverage feature class that has them.

14. Scroll down to and click the CODE attribute. You can
see a description of its data type and values.
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Contents | Preview Metadata

Details for vegetation.pat =l
Type of object: Feature Class
Number of records: 884
Description
Attributes
FID
SHAPE
AREA
PERIMETER
YEGETATION#
VEGETATION-ID
CODE
Data type: Float
Width: 8
Qutput width: 16
Murnber of decimals: 3
Definition:
The type of vegetation that can be found in each
polygon. =l

15. Click the Contents tab in the ArcCatalog window.

Now that you’ve familiarized yourself with the data, you
can create a map describing the study area within
Yellowstone National Park.

Add a layer to a map

The Yellowstone folder contains a map document. The map
already has data from the roads feature class and the
hillshade raster dataset. You must still add the water
features in the park to the map.

Adding data to a map is easy—all you have to do is drag
data from the Catalog and drop it on the map. When you
drop a layer onto a map, a copy of the layer is created and
stored inside the map document. In this way, you can create
a layer once and use it in many different maps. Before you
can add more data to the yellowstone map, you must open
the map document in ArcMap.

1. Click the Yellowstone folder in the Catalog tree.

2. Double-click the yellowstone map document in the
Catalog; it opens in ArcMap.
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In the ArcMap window, you see the contents of the
Study Area data frame in Data view; the name of the
active data frame appears in bold in the table of con-
tents. The map has two other data frames as well:
Yellowstone National Park and United States.

Arrange the ArcMap and ArcCatalog windows so you
can see the table of contents in ArcMap and the Catalog
tree at the same time.
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QUICK-START TUTORIAL

Water features must be added to the map; they should
draw underneath the park roads layer but above the
hillshade layer. The map’s table of contents reflects the
order in which layers are drawn.

4. Click and drag the hydrology layer from the Catalog
and drop it in the map’s table of contents below park
roads in the Study Area data frame’s list of layers.

E £F Study Area
= park, roads

= hillzhads '

Walue

High : 254 000000

Lo : 1.000000

5. Inthe ArcMap window, click the Save button.

The water features draw underneath the road features and
above the hillshade image in the map.

Create layers

The features in the park roads and hydrology layers cover
the entire park, but you only want to map the study area.
The mask shapefile represents the area outside the study
area. You can create a layer from this shapefile in the
Catalog and add it to the map to hide features that extend
beyond the study area.

If you add data directly to a map rather than creating a
layer first, ArcMap creates a new layer in the map docu-
ment. After modifying the layer’s symbology and other
properties, you can save it as a layer file outside the map
document so you can reuse it in other maps.
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In this task, you will first save the park roads layer to a file,
then create a new layer representing the mask shapefile.

1. Right-click the park roads layer in the map’s table of
contents and click Save As Layer File.

Eg Study Arca ]

=] park roads

B hydoogy  |#9 Hemove
£ b steams Open Attibule Table

BB rivers Joins and Fielates b

= <, Zoam To Layer

=] lakes
= Wisible Scals Range 3
E B hilshads Seloction >
Walug
High - 254, Label Features
Low - 1,001 Larvert Labiels o Anhatation,
“Z% Convert Features to Graphics
Display Diata »
| Diawing = K (73| =

2. In the Save Layer dialog box, navigate to the
Yellowstone folder. Type a name for the new layer, for
example, “park roads”, then click Save.

Loskin. [ ellowstone = = colsmled [:

clevation
i hydioloy Iy

Cancel

Mame: [park roads

Save as type: [Layer fes [ br) |

In the Catalog tree, click the Yellowstone folder.

4. Click the View menu and click Refresh. The park roads
layer now appears in the Contents list.
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5. Right-click the mask shapefile and click Create Layer.
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6.

g hydiology

- ‘mask

'@ park. Copy
study 3 Delete

Chrl+C

Fename

[ Search Resu
ﬁ Export b

g FewienHemateh dddreszes,.

Properties. .

Navigate to the Yellowstone folder in the Save Layer As
dialog box. Type a name for the new layer, for example,
“feature mask”, then click Save. The layer appears in
the Contents list for the Yellowstone folder.

Right-click the feature mask layer and click Properties.
The Layer Properties dialog box appears.

@ elevation
@ feature mazk

[a--% hillshade Copy  ChkC
----- hwdrology
B mask a4 Delete
@ park roads e
B study_area Create Layer...
- Ji#] tin_study
- [EE] vegtvpe Properties. ..
@ yellowztone

Click the Symbology tab.

Click the button showing the current symbol for the
layer. A symbol is assigned at random when the layer is
created.
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Layer Properties [ 7] x]

General| Souee| Selection | Display  Svmbology | Fiskds | Definiion Guery | Labes |
Show
feoo————— [Draw all fealures using the same symbol

Featurcs
Single symbol o r
Categories Symbal——
4| —

Quantities
Multiple Attributes

~Legend

Label appearing nest ta the symbol in table of contents
Description

Additional deseription appeating nes ta the symbalin your map's legend

[0k | coea | o |

10. Click the dropdown arrow next to the Fill Color symbol
and click white.

Symbol Selector 2]

. | [ Preview
Elue “ellow

Gireen

|:| D |:| pi
Hallow Lake Rose Eill Color. [
[ Ho Color

Dutline Width: QD Ooooooog
Sand *Yellow Qlive

a
oEgooodoodm

OuineColor M @EEENO0DEDEE
Green Jade Blue

MoeSm@EOO0OO0NEEE
EEENO0000DNEEN
S _EEEEEEEEEEEEN

’_‘ ’_‘ ’_‘ = | More Colars...

11. Click the dropdown arrow next to the Outline Color
symbol and click black.

12. Click OK in the Symbol Selector dialog box and click
OK in the Layer Properties dialog box.
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Now that you’ve finished creating the feature mask layer,
you should document its contents. Before adding it to the
map, you can import metadata, which has already been
created for the layer.

Import metadata

There is a text file in the Yellowstone folder containing
metadata describing the feature mask layer. By importing
this metadata it will become part of the layer itself; it will
be copied and moved with the data and updated automati-
cally by ArcCatalog. This is useful because when metadata
is maintained separately, it is easy to let it get outdated.

1. Click the feature mask layer in the Catalog tree.

2. Click the Metadata tab. By default, ArcCatalog auto-
matically creates metadata for the feature mask layer.
Information such as the name of the layer file will be
included automatically along with documentation hints.

Contertt | Prevess Metadits |

feature mask.lyr

Layer

Spatial | Attributes

Keywords
Thama:

- |

~

3. Click the Import metadata button on the Metadata
toolbar.

Shleshest; I ESRI

A
I

Import metadata
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4. Click the Format dropdown list and click FGDC

CSDGM (TXT). The metadata in the text file is struc-
tured following the format, which is supported by the

Now there is just one thing missing from the layer’s
metadata—a thumbnail describing how the layer will
appear when added to a map. Creating thumbnails for

FGDC’s metadata parser, mp. data sources and layers is a manual process.

5. Click Browse and navigate to the Yellowstone folder. 8. Click the Contents tab. Instead of a thumbnail, the
layer’s icon appears on a gray background.

9. Click the Preview tab.

6. Click the Files of type dropdown arrow and click All
files (*.*). Click the file “feature _mask.met™ and click

Open. 10. Click the Create Thumbnail button on the Geography
toolbar.

Lockjn |50 Vellowsstone =l gl

|3 dem3n boundary.sbr dem30.nd hills

| info ] baundary.sbx [38] elevation lyr 21 hills

|0 states hnur\dar: shp eleva:mr\ I:r sl mus J @ @ ﬁ{fr? O | 0 | S;E ‘

|23 tin_study boundary.shp.xml feature mask lyr hyd |

|1 vegetation ] boundary shx @] festurs mask Iy sl [ hyd .

(8] boundany bt ] dem30.aux [Sliature, maskmet e Create Thumbnail

gy 2l

File pame:  [feature_mask.met Open | . .

Fiesotbpe: [raries -9 S 11. Click the Contents tab. You can see the thumbnail both

W gl here and in the layer’s metadata.

7. Click OK in the Import Metadata dialog box.

Contents | Previewl Metadatal

Mame:  feature mask.lyr

Conterts | Proves  Metsdus
: 1 Type: Layer

Mask to hide features on a map that extend
outside the study area

Layer

s pes

|

tfeatue mask} |

After adding or removing features from a data source or
changing a layer’s symbology, you may wish to update the

The documentation in the feature mask.met file has item’s thumbnail.

been added to the layer’s metadata, replacing the
Catalog’s documentation hints.
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Search for items

You’ve explored the contents of the Yellowstone folder and
created the new feature mask layer, and soon you’ll add it
to your map. However, often you know what data you need
to use but not where it’s located. The Catalog lets you
search for data by its name, type. and geographic location.
You can also search for data using dates and keywords that
reside in the data’s metadata. When metadata exists, its
name, type, and geographic location are derived from the
metadata as well.

Suppose you didn’t know the feature mask layer existed.
You need to add a data source to the yellowstone map that
shows the boundary of the study area within the park.

1. Right-click the Yellowstone folder in the Catalog tree
and click Search. The Search dialog box appears, and
the location in which the search will begin looking is
automatically set to the Yellowstone folder.

& Search - My Search HE
Hame & location | Geography | Date | Advanced |
T Findton
Marne: I‘
Stan
Type: A1cIM5 Feature Service = Clear
ArclMS Image Service Mew Search
SIS Intemet Server
Arclnfo Coverage 5 .
Arclnfo Coverage Relationship Class avelay:
vl Workspace My Search
ALtaCAD Dirawing Exchange Format
| AutaCAD Drawing File LI
Search |Eatalng j
Laok in: IC:\Cat_Tulona\\YeHowstone =

2. Click the Advanced tab.

~

3. Click the Metadata element dropdown arrow, scroll
down, and click Theme Keyword in the list.

QUICK-START TUTORIAL

4. Click the Condition dropdown arrow and click equals.
5. Click in the Value text box and type “boundary™.
6. Click Add to List.

& Search - My Search [Z1x]

Name&\ocal\onl Geoglaphyl Date  Advanced |
Find Mow

- Defing additional search criteria

Stam

Mew Search

Save an

My Seach

Metadata element: Conditian Walue:

=] Jequas =] [boundary

Theme Keyword

Theme Keyword equals boundary

Data being searched has to mest all search criteria (i.e. criteria are ANDed)

elete Delete All

™ Match case

@

With this search, ArcCatalog will look in the Yellowstone
folder for items whose metadata includes the theme
keyword “boundary”.

7. Click Find Now.

The search is saved in the Search Results folder and is
selected in the Catalog tree. As the items are found that
satisfy the search criteria, shortcuts to those items are
added to the search’s list of results. When a Search is
complete, the message “Catalog search finished™
appears in the status bar of the ArcCatalog window and
the Stop button becomes unavailable in the Search
dialog box.

8. Click the Close button in the upper-right corner of the
Search dialog box.
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The Catalog has found four items in the Yellowstone
folder that satisfy the search criteria: three shapefiles
and the feature mask layer. Shortcuts to these items
appear in the Contents tab. In the Catalog, you can
work with shortcuts the same way you would work with
the items themselves.

9. Click the shortcut to the feature mask layer in the
Contents tab.

10. Click the Preview tab to draw the layer.
11. Click the Metadata tab to see the layer’s metadata.
This is the data you want to add to your map.

12. Click and drag the shortcut to the feature mask layer
from the Catalog and drop it in the map’s table of
contents above park roads in the Study Area data
frame’s list of layers. Now you only see features inside
the study area on the map.
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13. Click the Save button.

The yellowstone map now contains all the basic data
needed to represent the study area. Now all you need to do
is add a few finishing touches to the map’s layout.

Complete the map

The purpose of the yellowstone map is to illustrate the
different types of vegetation within the study area. Cur-
rently, the Study Area data frame shows most of the park.
You need to zoom in on the study area; do this in layout
view to make sure you’'re zoomed in as far as possible but
still able to see the entire study area in the layout. When
you switch to layout view, you’ll see the Yellowstone
National Park and United States data frames as well.

1. Click the View menu and click Layout view. You can
see all the data frames and the map’s title and scale bar
in the layout.
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In the Yellowstone National Park data frame, there 1s an
orange rectangle representing the area that you can see
within the Study Area data frame. Similarly, in the
United States data frame there is a green rectangle
representing the area that you can see within the
Yellowstone National Park data frame.

When you zoom farther in to the features in the Study
Area data frame, the extent rectangle on the
Yellowstone National Park data frame decreases in size
and the scale bar increases in size.

2. In ArcMap, click the Zoom In button on the Tools
toolbar and draw a rectangle around the study area in
the Study Area data frame.

YRR L
[ [
Zoom In

Go Back To Previous Extent

If you zoom in too close, you can return to your previous
extent by clicking the Go Back To Previous Extent
button.
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When the study area fills the Study Area data frame,
click the Save button.

4. Click the File menu and click Exit to stop ArcMap.

In ArcCatalog, click the Contents tab and click the
Yellowstone folder in the Catalog tree.

98]

In this exercise, you saw how to explore your data in the
Catalog, create layers, import metadata, search for items,
and add them to maps. In the next exercise, you’ll create a
layer illustrating the different types of vegetation that can
be found within the study area. This requires changing a
data source to a different format and modifying its values.

If ArcView or ArcEditor is installed on your computer, you
should continue on to Exercise 3; you’ll define a
shapefile’s coordinate system, modify its contents, and then
use it to create the vegetation type layer. If ArcInfo is
installed on your computer, you should continue with
Exercise 4; you’ll define a coverage’s coordinate system,
modify its contents, and then use it to create the vegetation
type layer. The title bar of the ArcCatalog window shows
you which version of the ArcGIS™ software you have
installed on your computer.

You can continue on to the next exercise or stop and
complete the tutorial at a later time. If you do not move on
to the next exercise now, do not delete your working copy
of the tutorial data. Also, do not remove the folder connec-
tion that accesses the working copy of the tutorial data
from the Catalog.
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Exercise 3: Managing shapefiles

Assembling data for a project often requires significant data
management work. In this exercise, ArcView and ArcEditor
users will create a layer representing the different types of
vegetation in the study area and add it to the yellowstone
map. In doing so, you’ll learn how to define a shapefile’s
coordinate system, modify attributes, join a table’s attributes
to a shapefile, and update their metadata using tools that are
available in the Catalog. If ArclInfo is installed on your
computer, skip to Exercise 4.

Define a shapefile’s coordinate system

In the previous exercise, when you looked at metadata for
the boundary shapefile you found that its coordinate system
was not defined. The features in the shapefile are projected,
but the Catalog doesn’t know which map projection was
used. Without that information, the Catalog can’t determine
where on the earth’s surface the features are located.

A shapefile’s Properties dialog box lets you modify its
attributes, create spatial and attribute indexes, and define its
projection.

1. Inthe Contents list, right-click the boundary shapefile
and click Properties.

2. Click the Fields tab.

Under Field Name, click Shape. This column contains
the feature geometry. The shapefile’s spatial properties
appear in the Field Properties list below.

At the bottom of the list is the Spatial Reference
property. The shapefile’s coordinate system is un-
known.

98]
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— Field Propertie:
Geometry Type Palygon
Ay Mum Poirts u]
Giricd 1 1000
Gric 2 1]
Girid 3 1]
Cortaing £ values [{ls]
Cortaing M values Io
Default Shape field Mo
Spatial Reference Unknoeeen o

Click the ellipses (...) button to the right of the Spatial
Reference property.

All data sources in the Yellowstone folder except for
the states coverage use the same projection. You can
copy coordinate system information from any data
source in the folder except states to this shapefile.

Click Import in the Spatial Reference Properties dialog
box.

Select... Select a predefined coordinate zystem.

Import & coordinate system from an existing

| featuie datasst or feature class.

Mew =| Create a new coordinate system.
Edit the properties of the curently selected
Mediys. coordinate systenm.
Savebs Save the coordinate zystem to a file.

QK | Cancel | Apply |

. Navigate to the Yellowstone folder, click the dem30

raster dataset, then click Add. The projection param-
eters from the dem30 raster dataset appear in the Spatial
Reference Properties dialog box.

Click OK. The shapefile’s coordinate system appears in
the Shape column’s Spatial Reference property.
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8. Click OK.

A shapefile’s coordinate system information is stored in
a .prj file with the data—for example, boundary.prj.
Now you can update the shapefile’s metadata with the
new coordinate system information. By default, every
time you look at metadata in the Metadata tab, the
Catalog automatically updates the metadata with the
data source’s current properties.

9. Click the Metadata tab.
10. Click the Spatial tab in the metadata.

Cortents | Freview Metadata |

- . =
_oesorprion [JETERI erbuees

Horizontal coordinate system
Projected coordinate system narme:
NAD_1827_UTM_Zane_12M
Geographic coordinagte system name.!
GCE_Morth_american_1927
Details

Bounding coordinates
Horizontal

In decimal degrees
IWes#: -111.153611
Ezst; -109.815017
North: 45.102127
South: 44133057

In projected or local coordinates =l

The Catalog has updated the coordinate system in the
metadata and has calculated its extent in decimal degrees.

Modify attributes in dBASE tables

A layer can join or relate attributes in a table of any format
to its geographic data source as long as they share a column
of values. The only requirement is that the columns have
the same data type. You must look at the vegetation
coverage’s attributes and the vegtype dBASE table’s

QUICK-START TUTORIAL

columns to see if modifications are required before they can
be joined together.

Using Table view, you can see that the vegtype dBASE
table has two columns that contain no values and that the
attribute named “CODE” in the vegetation coverage’s
polygon feature class and the column named “VEGID” in
the vegtype table contain the same values. Use the
coverage’s metadata to see the data type of the CODE
attribute, then use the table’s Properties dialog box to
modify its columns appropriately.

1. Click the vegetation coverage in the Catalog tree.
2. Click the Attributes tab in the metadata.

3. Scroll down to and click the CODE attribute. Its data
type is Float.

4. Click the Contents tab in the ArcCatalog window.

Right-click the vegtype table in the Catalog tree and
click Properties.

6. Click the Fields tab. The table’s columns and their data
types are listed. You can see that the VEGID column’s
data type is Long Integer.

The values in the VEGID column in the dBASE table
are integers, while the CODE column in the coverage
contains floating point values. To join the table to the
coverage, the values in both columns must have the
same data type. Therefore, you must add a floating
point column to the table.

7. Scroll to the bottom of the list of column names. Click in
the empty row under the name of the last attribute and
type “VEGTYPE™.
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8. Click under Data Type to the right of the new column’s
name, click the dropdown arrow that appears, then click
Float.

9. In the Field Properties list below, click to the right of
Precision, click again, then replace the zero with “4”.

10. Click to the right of Scale and replace the zero with
44177.

DBASE Table Properties HE

Genersl  Fields |\ndek I

Field Mame Data Type ILI
MAMET Text
LATINA Text
MAME2 Text
LATINZ Text _I
MAMED Text
LATING Text
WEGTYRE Flost
-]
Click any field ta see its properties.
i~ Field Propertie:

|Precision [4 [ ]
|Scale 1l [ ]

The new attribute has been defined. Now you can
remove the empty columns from the table.

11. Point at the gray button to the left of the NAME3
column; the mouse pointer changes to an arrow. Click to
select the column.

DBASE Table Properties HE
General Fislds | Index I

Ficld Mame Data Type I;l
RAMET Text
LATIN Text
MAMEZ Text

LATINZ Text _I
LATING Text
WEGTYPE Float

[
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12. Press Delete. The column is removed from the list.

13. Repeat steps 11 and 12 for the LATIN3 column to
delete it from the table.

14. Click OK.

Now that the vegetation shapefile has a new integer
attribute, you must copy the values in the original VEGID
attribute to the new VEGTYPE attribute. To edit the values
in a table, you must use ArcMap.

Calculate attribute values in ArcMap

To edit a table’s values you must add the table to a map.
With the Editor toolbar visible and the table opened, you
can start editing its values. Use the field calculator to copy
values from the CODE attribute to the VALUE attribute.

1. Click the Launch ArcMap button in ArcCatalog.

j=|am B

wE(ER A Q@

I
Launch ArcMap
2. Click OK to start using ArcMap with a new, empty
map.

Drag the vegtype table from the Catalog and drop it
onto the table of contents or the canvas in the ArcMap
window.

4. Click the Source tab in the map’s table of contents. The
table’s data is available within the map.

98]

x|
B £# Layers
= ‘g CACat_Tutorialvellor
vedtype
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5. Click the Editor Toolbar button; the Editor toolbar
appears.

|\-I;||n:n

A Z| &| w2

Editor Toolbar

6. On the Editor toolbar, click the Editor menu and click
Start Editing.

JdltDrV|F|! |

Start Editing

Stop Editmg
Saye Edits

7. Right-click the vegtype table and click Open. The
table’s values appear in a table window. The headings
of the columns whose values you can change have a
white background.

8. Right-click the heading of the VEGID column and click
Freeze/Unfreeze Column. It is now positioned at the left
of the table with a heavy black line to its right.

9. Scroll horizontally in the table until you see the
VEGTYPE column.

10. Right-click the heading of the VEGTYPE column and
click Freeze/Unfreeze Column. It is now positioned to
the right of the VEGID column at the left of the table
with the heavy black line to its right.

11. Right-click the heading of the VEGTYPE column and
click Calculate Values.

QUICK-START TUTORIAL

E Attributes of vegtype

VEGID JYEGTYPE, 1 rAnc
Sart Azcending

Sort Dezcending

M R

Summarize. ..

Calculate Values..

Statistics...

Freezenfreeze Calumn

@A e O
nnoo|o/o|Io| oo

12. Scroll down and double-click VEGID in the Fields list.
“|VEGID]” appears in the text box below “VEGTYPE
=7, ArcMap reads this as VEGTYPE=[VEGID]; all
values in the VEGTYPE column will be set equal to the
values stored in the VEGID column.

Field Calculator H

Fields Tupe Functions

HAMET Bl & punber
MAMEZ
oD " Sting
PRIMARY

TYPE  Date
VEGID

VEGTYPE -

1 | »
WEGTYPE = I Advance
[VEGID]

Cancel

13. Click OK.

As ArcMap calculates the new values in each record,
you can see how many records have been completed at
the bottom of the Field Calculation dialog box.

14. Look at the VEGTYPE column in the table; its contents
are the same as the VEGID column.
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15. Click the Close button in the top-right corner of the table
window.

16. Click the Editor menu on the Editor toolbar and click
Stop Editing. Click Yes to save your changes.

17. Click the File menu and click Exit to stop ArcMap.
Click No when prompted to save the map.

Now that the vegetation coverage and the vegtype table
have matching columns, you can create a layer that links
the two together.

Create a layer using the related attributes

Through a layer you can join the attributes stored in the
vegtype table to the vegetation coverage and use the table’s
values to query, label, and symbolize the coverage’s
features.

1. Click the Yellowstone folder in the Catalog tree.
2. Click the File menu, point to New, then click Layer.
3. Type a name for the layer such as “vegetation type™.

4. Click the Browse button, navigate to the Yellowstone
folder, click the vegetation coverage, then click Add.

5. Check Store relative path name, then click OK. Relative
path names let you continue using the layer even after
moving or renaming the Yellowstone folder.

Create New Layer

Specify a name for the layer:

|vegetaliom type

Chaose the data zource you wart the layer to use:
IC.\CaLT utorialky'ellowstonehvegetation =

¥ Create thumbnail
¥ Eicre elative path name

Cancel |
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6. Right-click the vegetation type layer and click Proper-

ties.

7. Click the Joins & Relates tab in the Layer Properties

dialog box.
Click the Add button next to the Joins list.

9. Click the first dropdown arrow to specify what you

want to join to this layer, then click Join attributes from
a table.

10. Under step 1, click the dropdown arrow and click the
CODE attribute.

11. Under step 2, click the Browse button.

12. Navigate to the Yellowstone folder, click the vegtype
table, and click Add.

13. Under step 3, click the dropdown arrow and click the
VEGTYPE column.

Join Data [ 7] x]

Join lets you append additional data ta this layer's attnbute table so pou can,

for example, symbolize the laver's features using this data.

‘what do you want to join to this layer?

e attribuites from & table

1. Choosge the field in this layer that the join will be bazed on:
|cone =l
2. Choose the table to jain to this layer, o load the table from disk:
[vedvee =l
¥ Include attibute tables of lapers in this ist
3. Chaose the field in the table to base the join on:
VEGTYPE =l

14. Click OK in the Join Data dialog box. The vegtype table
is added to the list of tables that have been joined to the
coverage.
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Layer Praperties

HE

General | Sowce | Selection | Display | Symbology | Fields | Defirition Query | Labels Joins & Relates |

—ain;

Lists the dlata that has been appended to this
table's/layer's attibute table

vegiype Add.. g Lo
Hemove Femayve
Femave All Femaveal

Lists the data that has been assaciated with this
tablelaye

[k | conea ]

To change the color of individual values, for example, to
make the water polygons blue, double-click the patch of
color to the left of the value. Set the fill and outline

colors in the Symbol Selector dialog box and click OK.

20. Click OK in the Layer Properties dialog box.

The vegetation type layer represents the forest resources in
the study area.

Add the vegetation type layer to the map

Now that the vegetation layer has been created, you can

15. Click the Symbology tab.
16. Click Categories in the Show list.

17. Click the Value Field dropdown arrow and click
vegtype. TYPE.

18. Click the Color Scheme dropdown arrow and click a
different color palette, if desired.

19. Click Add All Values.

Layer Properties HE
Genersl| Sowse| Selsstion | Display Symbolosy | Fields | Definition Query | Labels | Joins & Rielstes |
how
p— Draw using unique values of one field. Impoit
Categories Yalue Field 1 Lolor Schem
’VIVeglype TYPE j| ’V [ B -
Unique values, many |
Maloh o symmbols in & Symbel | Value T Latel [ Count_[
Quantities
Charts () <all other valugs: <all other valugs>
Multiple Attributes <Heading> veglype. TYPE
I corbined combined 2
[ forest forest 7
[ Jronforest norforest z !
[ water water 7
[ wetforest wist forest 7 !
g : ; % AdddllValues | AddValues. | B valucs | advapced- |
h
ok || ceneel | sn |
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add it to the yellowstone map.

L.

Double-click the yellowstone map in the Catalog.

2. Click and drag the vegetation type layer from the

W

Catalog and drop it in the map’s table of contents below
park roads and above hydrology in the Study Area data
frame’s list of layers.

A message appears indicating that the vegetation type
layer is missing spatial reference information. ArcInfo
users define the vegetation coverage’s coordinate
system in Exercise 4.

Click OK to add the vegetation type layer to the map.
Because the vegetation coverage’s features share the
same projection as the other data sources in the Study
Area data frame, the vegetation features draw on the
map in the proper location even though their coordinate
system hasn’t yet been defined.
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%_yellowstone. mxd - ArcMap [_[O] x]

File Edit Yiew Inseit Selection Tools Window Help ‘
D& B@x o |+ me v|@|i§]|k‘?|
CERE R Lo L R =l
Edtor v | b | # 7 | Tesk: [Ceate Now Feae || Tece E =GR E
e I Lot 2B 2B BB 1100
B £F Study Area =l
B # featue mask b )
O Yellowsione Hational Park
Sh - F t
= ok roads . udy area- Farest resources
B B vegetationlype o]
veg_infa TR (|17
[ conbined
I forest B [P————
[ nenfarest
[ water " | ! :
0 wet forest = | o e . e | 1L I B
B ¥ hydilogy | ; FRd
B streams RE| s
58 e A ]
| e
B F ke | i ; i :
] & e -
EL M hilshade S
4] | » 3
L =l
Display | Source 26 ] | ]
JDlawwng' k@‘DvAth‘Anal 1[0~ 51g|év&-iv;v
Change to a diferent font o | [6.46 D.07 Inches 7

4. Click the Save button in ArcMap.
5. Click the File menu and click Exit to stop ArcMap.
The yellowstone map is now complete.

You’re now finished with the Quick-start tutorial. This
exercise showed how to use ArcCatalog to manage your
shapefiles and dBASE tables. You saw how to define a
shapefile’s coordinate system, add and remove attributes,
calculate attribute values, and symbolize features using
attributes stored in another table.

Overall, this tutorial has introduced you to a wide range of
tasks. Whether you are looking for data, building maps, or
managing data for your project or an entire organization,
the Catalog plays a pivotal role in getting the job done. The
remaining chapters in this book look in detail at the variety
of tasks you can accomplish with the Catalog.
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Exercise 4: Managing coverages

Assembling data for a project often requires significant data
management work. In this exercise, ArcInfo users will
create a layer representing the different types of vegetation
in the study area and add it to the yellowstone map. In
doing so, you’ll learn how to define a coverage’s coordi-
nate system, add and delete attributes, update metadata, and
link a coverage and an associated INFO table using tools
that are available in the Catalog.

In addition to ArcInfo Desktop, you must have ArcInfo
Workstation or a geoprocessing server installed on your
computer to be able to complete this exercise. ArcView and
ArcEditor users must follow Exercise 3 instead.

Set a coverage’s coordinate system

In Exercise 2, when you looked at metadata for the vegeta-
tion coverage you found that its coordinate system was not
defined. The features in the coverage are projected, but the
Catalog doesn’t know which map projection was used.
Without that information, the Catalog can’t determine
where on the earth’s surface the features are located.

In addition to creating topology and setting tics, extents,
and tolerances for a coverage, you can define its coordinate
system using the Coverage Properties dialog box. You can
copy coordinate system information to and from coverages,
grid-based raster datasets, and TIN datasets. The dem30
and the tin_study data sources in the Yellowstone folder
use the same projection as the vegetation coverage.

1. Click the Yellowstone folder in the Catalog tree.

2. In the Contents list, right-click the vegetation coverage
and click Properties.

QUICK-START TUTORIAL
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Coverage Properties [7]]

General Projection | Tics and Exlentl To\elancesl

& Display Spatisl Reference ¢ Display PR fils

Unknown Cooidinate System

Define

0k || Cencel | s |

Arcinfo

Click the Projection tab and click Define.

4. Click Define a coordinate system for my data to match

existing data and click Next.

5. Click the Browse button to the right of the Dataset text

box.

6. Navigate to the Yellowstone folder, click the dem30

raster dataset, then click Open.

* Define Projection Wizard [coverages. grids, TINs)

Choose a dataset with the coordinate system
you want to use

Dataset:

i\ Cat_Tutoniallvelonstoneiin_study
Coordinate system parameter
The parameters listed below ars thoss of the match dataset. They
will be used to define a coordinate syskem for your data:
Projection  DTH -
Zone 1z
Datuw HADZ7
Zunits METERS —
Units METERE
Sphernid CLADKE1866 52
HElR < Back Next = Cancel
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The projection parameters used by the raster dataset
appear in the Coordinate system parameters list.

7. Click Next and click Finish.

8. The name of the projection and the spheroid or ellip-
soid it uses appears in the Properties dialog box. To list
the projection’s parameters, check Show spatial refer-
ence details. Click Display PRJ file to see the param-
eters in ArcInfo Workstation format.

9. Click OK.

Now that the coverage’s projection has been defined, you
won’t have any trouble adding its data to any map, regard-
less of the map’s projection.

Convert your data to a different format

ArcToolbox provides many different tools for converting
your data. The most common data conversion tools have
been included in the Catalog. If the conversion tool you
need isn’t listed, start ArcToolbox and look in the Conver-
sion Tools toolset.

1. Inthe Contents list, right-click the vegtype dBASE
table.

2. Point to Export and click dBASE to INFO. The vegtype
table is automatically listed as the Input dBASE table.

Click the Browse button to the right of the Output
INFO table text box.

4. Navigate to the Yellowstone folder. Type a name for the
new table—for example, “veg info”—into the Name
text box and click Save.

98]
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* dBASE to INFO

Input dBASE table: IE:\Eal_Tutorla\\Yellowstune\vegtypedbl EI :

Cancel

Datalype mapping:  (* Defaul mapping ¢ Define mapping |
Help

= Field defirition

dBASE field I\-fEEID 4 :

|4—
Output width: IE—
Decimal places: ID—

utput INFD table:~[CACAL_Tutorisysllowstonshueg_ino E"l Batch =

Field name: VEGID Item name:
Field width: & Itern width:
Output width: 5
Field type: Integer Item type:

Decimal places: 0

5. Click OK. A dialog box appears showing the progress of
the conversion tool. When the tool has finished running,
the dialog box disappears and the new veg_info INFO
table appears in the Yellowstone folder.

Now you must look at the vegetation coverage’s attributes
and the veg_info table’s columns to see if other modifica-
tions are required before they can be linked together.

Modify attributes in coverages and INFO tables

The relationship between the vegetation coverage and the
veg_info table is established by creating a coverage rela-
tionship class. A relationship class is similar to an ArcInfo
relate, but it lets you define the relationship more accu-
rately. Once created, a relationship class lets you query,
label, and symbolize features in the coverage using at-
tributes in the associated table.
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When creating the relationship class, you define which
column in the feature class’s attribute table and which
column in the INFO table share the same values. The
columns must also share the same data type.

Using Table view, you could see that the vegetation
coverage’s polygon feature class has a column named
“CODE”, and the veg_info table has a column named
“VEGID” that contains the same values. Use the Properties
dialog box for the feature class and table to see if the
columns have the same data type.

L.

98]

Right-click the veg_info INFO table in the Catalog and
click Properties.

Click the Items tab. The columns in the table and their
data types are listed. The VEGID column has a data
type of Binary and an input width of four.

Because this column will be used to join the table’s
values to the coverage, it should be indexed.

Click the VEGID attribute and click Add Index. The
value in the Indexed column in the Properties dialog
box changes from No to Yes.

Info Table Properties [2]x]

General tems | Relationships |

Items

[Coturan T item Name [Type [width [ Dutput] N.Dec [Indeved [ Al Name] Re « |

N/& ROWID 0D 4 5 NA HNo
[} Cha 8 B N&
CODE Cha 24 24 N4 M [
CODE2 Char 17 17 N/& | No He
TFE Cha 10 10 N/& Mo He
PRIMARY Char 35 35 N/ No He
NEMET Cha 60 B0 N/& Mo He
LATIN Char 55 55 N/ No He
NEMEZ Cha 53 63 N/& Mo He
LATINZ Cha 55 55 N/ Mo He
NEMES Cha 20 20 N/ Mo Ei;l

»
T Egdlnder || Delete Index Delste st | Ea. |

If you looked at the contents of the original vegtype or
the new veg_info table, you would see that the NAME3

QUICK-START TUTORIAL
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and LATIN3 columns don’t contain any values and can
be deleted.

Scroll down to and click the NAMES3 attribute, then
click Delete. Click the LATIN3 attribute and click
Delete. The columns are removed from the list.

Infa Table Properties HE

General tems | Rlatianships |
Iberns:

Column [ Item Hame [Tvpe [width [ Output] M.Dec [Indexed [ AR Name[Re 4 |
=] Char 8B 8 N/ No Mc

13 CODE Char 24 24 MNéd No MNe
7 CODE2 Char 17 17 N No Mc
a4 TYPE Char 10 1 MNéd No MNe
B4 FRIMARY Char 35 36 N No Mc
99 MNAMET Char 60 E0 MNéd No MNe
154 LATINT Char
214 NAMEZ Char
LATINZ Char

NAME 3
LATING

Add Index Delete Index

Click OK.
Click the vegetation coverage in the Catalog tree.

Right-click the polygon feature class in the Contents list
and click Properties. The Properties dialog box for a
coverage feature class is the same as for INFO tables.

Click the Items tab. The attributes in the feature class
and their data types are listed. The CODE attribute has
a data type of Float.

The values in the VEGID column in the INFO table are
binary integers, while the CODE column in the polygon
feature class contains floating point values. To create a
relationship class the values in both columns must have
the same data type. Therefore, you must add a Binary
column to the polygon feature class.

9. Click Add.
10. Click next to Item name and type “VEGTYPE”.
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11. Click next to Type, click the dropdown arrow that
appears, then click Binary. The Input width defaults to
four, and the Display width defaults to five.

Add Item [ 7] ]
Item Properties:
Item property Walue
Column 25
Iterm Mames WEGTYPE
Type hd
Input width 4
Display width ]
Decimal places M/A
Altermate name
Rledsfined N
Ok Cancel

12. Click OK. The new attribute appears in the list of
attributes for the feature class.

Coverage Feature Class Propertics HE

General Items |F\elal\unsh\ps|

Colurnn | Iterm Name

N/& FID

[Tupe [width [Output] N.Dec [Indexed [ Al Name | Redel
oo 4 5 NA Mo No

N | SHAPE Geame d |5 N/ Yes Ha
1 |AREA Fost 4 12 3 Mo Ho
5 PERIMETER  Flat 4 12 3 MNe Ha
3 VEGETATION# Biney 4 |5 N/ Mo Ho
13 VEGETATIOND Binaw 4 |5 N/ MNe Ha
17| CODE Flost 5 153 Mo Ho
= 4 s

Add Indes | DeleleIndex Debte | [Add ] Ede

13. Click OK.

Now that the vegetation coverage has a new integer
attribute, you must copy the values in the original “CODE”
attribute to the new “VEGTYPE” attribute. To edit the
features and attributes in a coverage, you must use
ArcMap.
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Calculate attribute values in ArcMap

You must add a coverage feature to a map in order to edit
its attributes. With the Editor toolbar visible, you can start
editing the coverage. Open the feature class’s attribute
table and then use the field calculator to copy values from
the CODE attribute to the VEGTYPE attribute.

1. Click the Launch ArcMap button in ArcCatalog.

22 e Q

]
I
Launch ArcMap

2. Click OK to start using ArcMap with a new, empty
map.

98]

Drag the vegetation coverage from the Catalog and drop
it onto the table of contents or the canvas in the ArcMap
window. A layer is created for the coverage’s polygon
feature class and added to the map’s table of contents.

4. Click the Editor Toolbar button; the Editor toolbar
appears.

|;|;, ||n:u

)| &0| w2
I

Editor Toolbar

5. On the Editor toolbar, click the Editor menu and click
Start Editing.
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ditar v|F|!V| 1

i
lngl

Start Editing

Stop Editia

Save bdits

6. Right-click the vegetation polygon layer in the table of
contents and click Open Attribute Table. The attributes
of the polygon feature class appear in a table window.
The headings of the columns whose values you can
change have a white background.

7. Scroll horizontally in the table until you see the
VEGTYPE column.

8. Right-click the heading of the VEGTYPE column and
click Calculate Values.

CODE |YEGTYPE! -
45 n = SortAzcending
40 0 £ Sort Descending
= 0 2 Summarize. .
:i g Calculate Values...
E7 i} Statistics...

9. Double-click CODE in the Fields list. “|CODE]”
appears in the text box below “VEGTYPE =". ArcMap
reads this as VEGTYPE=[CODE]; in other words, all
values in the VEGTYPE column will be set equal to the
values stored in the CODE column. Click OK.
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Field Calculator [ 7]

Fields Type Functions

AREA 2| & Number
CODE

FID £ String

PERIMETER

Shape  Date

WEGETATIONH

WEGETATION-ID -
4 »

YEGTYPE = ™ Advanced

|CODE] J ﬂ il
Bl

As ArcMap calculates the new values in each record,
you can see how many records have been completed at
the bottom of the Field Calculator dialog box.

10. Look at the VEGTYPE column in the attribute table; its
contents are the same as the CODE column.

11. Click the Close button in the top-right corner of the
attribute table window.

12. On the Editor toolbar, click the Editor menu and click
Stop Editing. Click Yes to save your changes.

13. Click the File menu and click Exit to stop ArcMap.
Click No when prompted to save the map.

Now that the vegetation coverage and the veg_info table
have matching columns, you can create a relationship class
that links the two together.

Create a relationship class

When creating a relationship class, you must define the
properties of the relationship between the coverage and the
associated INFO table. One property of a relationship is its
cardinality, which describes how many features in the
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coverage are related to how many records in the attribute

table. The cardinality for this relationship is many-to-one;

that is, a group of plants defined in the veg_info table may
be found in many polygons in the coverage.

Because you're primarily interested in the vegetation
coverage’s features, the polygon feature class is the origin
in the relationship. The veg_info table is the destination.
The columns that link the two are called key attributes. The
VEGTYPE attribute in the coverage is the primary key;
the VEGID column in the veg_info table is the foreign key.

Path labels describe the relationship when navigated
forward and backward. In this relationship, going forward
from the origin to the destination, the vegetation polygons
relate to “types of vegetation™ in the veg_info table. Going
backward from the destination to the origin, the veg_info
table relates to “vegetation features™ in the coverage.

Now, create a relationship class linking the vegetation
coverage’s polygon feature class to the veg info table.

1. Click the Yellowstone folder in the Catalog tree.

2. Click the File menu, point to New, then click Coverage
Relationship Class.

Type a name for the relationship class, for example,
“vegetation_attributes”.

98]

4. In the Origin table/feature class list, click the plus sign
next to vegetation and click its polygon feature class.

5. In the Destination table/feature class list, click
veg_info.
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New Relationship Class HE

Mame of the relationship class:

Ivegatalmr\iatlrlhulas

Select the table/feature classes that will be associated by this relationship class

Origin table/feature class:

[#- states - . . .
B A elationship class is a collection of

wegetation tslatioriships bstween objects in bwo
&It tables/feature classes.
label
polygon
tic

£}

Pareels are owned by owners
Diners own parcels.

< Back I Next > I Cancel

Click Next.
Click Simple (peer-to-peer) relationship

and click Next.

In the first text box, type “types of vegetation™. In the
second text box, type “vegetation features”. Click Next.

New Relationship Class

Specify a label for the relationship as it is raversed from the
origin tabledteature class to the destination table/feature class

Ilypes of vegetation

Specify a label for the relationship as it is raversed from the
destination table/teature class to the origin table/feature class

Ivegelatiun features
‘which direction will messages be propagated between the
obiects related by this relationship class?

! Frnward [origin bo destination]

! Backward [destination o erigin)

) Both

' None [no messages piopagated)

< Back I Next > I Cancel
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As discussed at the beginning of this task, there is a
many-to-one relationship between the polygons in the
vegetation coverage and the vegetation types in the
veg_info table. In practice, a many-to-one relationship
is the same as a one-to-one relationship. Therefore, you
will create a relationship with one-to-one cardinality.

9. Click 1-1 (one-to-one) and click Next.

10. Click the dropdown arrow for the primary key field list
and click the VEGTYPE attribute.

11. Click the dropdown arrow for the foreign key field list
and click VEGID.

New Relationship Class

irnary key in the
object i fielc]. I this
i seleot the foreion key inthe de

. this il be the:
- you wil also nee

d

0 may
tion table/featur

Select the primary key figld in the origin table/feature class:
YEGTTPE B

Select the foreign key field in the destination table/feature class
that refers (0 the primary key field in the arigin table/feature class:

12. Click Next and click Finish. The vegetation_attributes

coverage relationship class appears in the Yellowstone
folder.
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@ tin_gtudy

veg_info
-2 vegetation_attibutes

[ veatype

----- @ pellowztone

You can find out which relationships a coverage feature
class or INFO table participates in by opening its Properties
dialog box and clicking the Relationships tab. Now you can
create a layer that takes advantage of this relationship.

Create a layer using the related attributes

Once a relationship class has been created, a layer can use
the attributes in the veg_info table to query, label, and
symbolize the vegetation coverage’s features.

1. Click the Yellowstone folder in the Catalog tree.
2. Click the File menu, point to New, then click Layer.
3. Type a name for the layer such as “vegetation type™.

4. Click the Browse button, navigate to the Yellowstone
folder, click the vegetation coverage, then click Add.

5. Check Store relative path name, then click OK. Relative
pathnames let you continue using the layer even after
moving or renaming the Yellowstone folder.

Create New Layer

Specify a name for the layer:

Ivegelat\un type

Chooze the data source you want the laver to use:
IE:\Eal_T utorialrellowstonehvegetation =

Cancel |

6. Right-click the vegetation type layer and click Proper-
ties.
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7. Click the Joins & Relates tab in the Layer Properties
dialog box.

Click the Add button next to the Joins list.

9. Click the first dropdown arrow to specify what you
want to join to this layer, then click Join data based on a
predefined relationship class.

Join lets you append additional data to this layer's attribute table so you can,
far example, symbolize the layer's features using this data.

Join Data

‘what do pou want to join to this laper?

IJom data bazed on a pre-defined relationship class ﬂ

A relationship class defines a relationship between the features in this
layer and the records in a table, or the features in another layer,

The list below shows all the relationship claszes that have been

defined for the data in this layer. Relationzhip classes are defined in
ArcCatalog

Choose the relationship class to base the join on:

Itypes of vegetation ﬂ

10. Click OK in the Join Data dialog box. The veg_info
table is added to the list of tables that have been joined
to the coverage.

11. Click the Symbology tab.
12. Click Categories in the Show list.

13. Click the Value field dropdown arrow and click

veg_info:TYPE.

14. Click the Color Scheme dropdown arrow and click a

different color palette, if desired.
15. Click Add All Values.

Layer Properties HE
General | Source | Selestion| Display  Symbelogy | Fields | Definiton Duery | Laels | Jains & Relates |
how
e Diaw categaries using unique values of ane field. g |
Categaries Valis Fisld Color Schem
Unique values [ veq_into: TYPE - ( . - =
Unique values, many | :
uu‘:\a‘;’”&f symbolsin 3 [7cbol [ Vakie T Latel |
Charts <all ather values> <all other values> 0
Multile Attibutes <Heading veq_info:TYPE a4
I combined combined 2
[ forest forest 292 u
[ Jronforest nan-forest 329 J
[ water wiater ]
Bl vt fores et et 1 o
[ pdd Al Vaes | | addvalves. | | Bemoevaues | Advanced- |
ok | cencel | apow |

To change the color of individual values—for example,
to make the water polygons blue—double-click the

patch of color to the left of the value. Set the fill and
outline colors in the Symbol Selector dialog box and

click OK.

16. Click OK in the Layer Properties dialog box.

The vegetation type layer joins attributes in the veg_info
table to the polygons in the vegetation coverage using
information from the vegetation_attributes relationship

Layer Propeities HE
General | Souce | Selection | Display | Symbology | Fields | Defintion Query | Labels Joins & Relates |
Lists the data that has been appended to this Lists the data that has been assoiated with this
table's/layers aftibute tabls tablelayer.
weg_infa Add... 7 o
Femeve HEre
Remove Al Remove Al
oK Cancel 5l
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class. Then, it symbolizes them using the table’s values. It
represents the forest resources, which are available
throughout the study area.
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Add the vegetation type layer to the map

Now that the vegetation layer has been created, you can
add it to the yellowstone map.

1. Double-click the yellowstone map in the Catalog.

2. Click and drag the vegetation type layer from the
Catalog and drop it in the map’s table of contents below
park roads and above hydrology in the Study Area data
frame’s list of layers.

& yellowstone.mad - ArcMap M= E

J Fle Edit View Insert Selection Took Window Help |

[B=i== = S A e -”Q‘@‘k?‘
Az ees Drone’ BRRHEDCDR S @
Editor = |> |.Iv ‘ Task: [Freale New Fealre = ‘ Terget | [ |/O‘X‘|:

I —— | 11 12 [E [ 15 5 7 [ 8 o, =
£ £ Study Area =]
=] feature mask

Vellowstone National Park
Study area- Forest resources

O
= park mads x|

=] vegetation type "
we_info:TYP

[ combined
[ forest EE
[ non-forest

[0 water
[0 et forest

E & hydrology
= hreams L

B & ivers
m

=] lakes

= - -
E) Bl hilshads -
1 » 3 _I

Display 3R] ] [
|oewigw & GO A~ Zffa ——  c[[0 5] B 7 u|Ar B Er -

Change to a diferent font ® | [5.46 0.07 Inches 7

3. Click the Save button in ArcMap.
4. Click the File menu and click Exit to stop ArcMap.

The yellowstone map is now complete.

QUICK-START TUTORIAL
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Update the coverage’s metadata

Over the course of this exercise, you defined the vegetation
coverage’s coordinate system, added a new attribute, and
created a relationship class linking the coverage to the
veg_info table. Now you should update the vegetation
coverage’s metadata with this information.

1. Click the vegetation coverage in the Catalog tree.

2. Click the Metadata tab. The Catalog has automatically
added the coverage’s coordinate system to the metadata
and has calculated its extent in decimal degrees.

Click the Attributes tab in the metadata.

4. Click the VEGTYPE attribute. The Catalog has added
this attribute and its data type information to the list.

98]

5. Scroll down to see information about the relationship
class in which the coverage participates. Relationship
class information isn’t included in the FGDC standard;
ESRI has defined a profile of that standard that includes
additional data properties.

To add descriptive information, for example, to docu-
ment the data contained in the VEGTYPE column, use
the Catalog’s FGDC metadata editor.

6. Click the Edit Metadata button on the Metadata toolbar.

Shyleshest: IESHI j 31' %‘ L_fﬂ = EL
i

Edit Metadata

7. Click Entity Attribute at the top of the metadata editor.
The editor is currently showing you metadata for the
polygon feature class.
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8. Within the Detailed Description tab, click the Attribute
tab.

jostion  Spatisl Fefererce  Enlity Attribute  Distibution  Metarats Refersnos
Detailed Desaription | Dervien Description|
Eriy Typs  Atibute |

General | Dates | Atribute Domein Valuss|

Label FID Wale Accuracy
Value Accuracy I
Type: (allsd Explanation:
Walue
it 4 Measurement =
Frequency:
Presision: P

Indexed:
Defirition: & unigue idertifier for each feature in the
Definition Source: |ESRI

x| 1] 4[]t 1ot @
[ %] 14] 4] » M| Detaled Description 1 of 2

Save Cancel Help

The Attribute tab currently shows metadata for the first
attribute in the polygon feature class, the FID attribute.
The Definition text box shows that this column contains
a unique value for each feature in the coverage.

9. In the toolbar at the bottom of the Attribute tab, click the
Move next button. The current attribute displayed in the
Attribute tab advances to the next one listed in the
coverage’s metadata—the SHAPE attribute, which
contains feature geometry.

+| x| 4] 4|i>|ri|| Attribute 1 of 8
Move next Move last
10. Click the Move last button to see the VEGTYPE
attribute.

11. Click in the Definition text box and type, “A number
identifying the type of vegetation in each feature. Use
this attribute to join this coverage to the veg_info table.”
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12. Click Save.
13. Click the Attributes tab in the metadata.

14. Click the VEGTYPE attribute. The description has been
added to the metadata.

Canterts | Preview Metodata |

PERIMETER =
VEGETATION#
VEGETATION-ID
CODE
YEGTYPE
Data type: Binary
Width: 4
Output width: 5
Definition:
& nurber identifying the type of vegetation in
each feature. Use this attribute to join this
coverage to the veg_info table,

Details for vegetation_attributes
Type of object: Relationship

|

Anyone who uses this coverage in the future will be able to
find out what its properties are, what data it contains, and to
which tables it is related.

This exercise showed how you can use ArcCatalog to
manage your data. You saw how to define a coverage’s
coordinate system, add and remove attributes, calculate
attribute values, symbolize features using attributes in a
related table, and use the FGDC metadata editor to docu-
ment your data.

Overall, this tutorial has introduced you to a wide range of
tasks. Whether you are looking for data, building maps, or
managing data for your project or an entire organization,
the Catalog plays a pivotal role in getting the job done. The
remaining chapters in this book look in detail at the variety
of tasks you can accomplish with the Catalog.
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